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INTRODUCCION

El manual que a continuacion se presenta, sirve para identificar los objetivos, los contenidos
y su programacion, correspondientes a la asignatura de Dibujo Técnico Industrial, enfocada
a la carrera de Ingenieria Diseno Industrial. El manual destaca las habilidades y valores que
desarrolla el estudiante al cumplir con cada objetivo, también da algunas directrices en
cuanto a los instrumentos didacticos y de evaluacion que podrian aplicarse durante el curso.

El objetivo de la materia consiste en proporcionar a los estudiantes de la carrera de
Ingenieria en Diseno Industrial, el conocimiento para del dibujo técnico industrial como la
base de la formacion de los ingenieros.

En el contenido de la asignatura se consideraran las leyes y las conclusiones de la
geometria descriptiva que son la base para la ejecucion del dibujo técnico asi como para
contribuir a desarrollar la imaginacion espacial, la comprension y posterior representacion
de las tres dimensiones del espacio y los métodos de representacion para las aplicaciones
propias del dibujo técnico industrial.

Un apartado importante de la presente asignatura sera la comprension y aplicacion de las
normativas para la generacion y lectura de informacion técnica ya que hoy en dia la
globalizacion nos ha forzado a estar en constante comunicacién con otras naciones por lo
gue es de suma importancia entender las normativas mas aplicadas a nivel mundial y poder
aplicarlas en el momento que sea requerido.

Para poder llevar a cabo los ejercicios de la materia, es necesario que el alumno tenga los
conocimientos basicos de dibujo, los cuales se aplicaran en la representacion grafica
técnica de objetos y elementos que se emplean dentro del diseno industrial

Al finalizar el curso el alumno tendra la capacidad de generar planos de informacion técnica
normalizados para la fabricacion de productos industriales a través de la aplicacion de
formatos de dibujo adecuados con un lenguaje técnico.
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igar, diagnosticar, disefiar y optimizar productos y

Universidad Politécnica de fa Zona Metropolitana de Guadalajara, Universidad Politécnica de Guanajuato.

‘Al completar a unidad de
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FICHA TECNICA

NOMBRE DE LA ASIGNATURA

Nombre:

Dibujo Técnico Industrial

Clave:

DTI-ES

Justificacion:

Para desarrollar la capacidad en el alumno para interpretar planos técnicos
basicos y dibujar elementos en dos dimensiones utilizando herramientas de
coémputo.

E | alumno sera capaz de elaborar e interpretar planos técnicos de elementos

Objetivo: variados para el desarrollo y fabricacion de los propios objetos y proyectos de
diseno a través de la utilizacion de herramientas CAD.
Conocimiento de las tecnologias y herramientas disponibles para
Habilidades: visualizacion, recopilacion y organizacion de informacion (digital y/o analoga).

- Habilidad para mostrar tridimensionalmente una idea o concepto.

Competencias
genéricas a
desarrollar:

-Capacidad para determinar las caracteristicas de un producto con
metodologias de diseno industrial para ubicar el producto o sistema dentro
del mercado

Capacidades a desarrollar en la asignatura

Competencias a las que contribuye la
asignatura

- Identificar condiciones y caracteristicas del
producto, del componente, uniones,
estructurabilidad y centro de gravedad para su
elaboracion a través de la aplicacion de las
tecnologias existentes y tecnologias

- Identificar caracteristicas de producto basado
en indicadores comparativos para la
elaboracion de conceptos.

- Determina aspectos cualitativos y
cuantitativos de soluciones existentes y nuevas
en razon de su funcion para la elaboracion y/o
mejora del producto. - Determina aspectos
cualitativos y cuantitativos de soluciones
existentes y nuevas en razon de aspectos
estético-formales para la fabricacion y/o
mejora de productos. - Determina las
caracteristicas del producto con metodologias
de diseno industrial para ubicar el producto o
sistema dentro del mercado - Determina los
procesos productivos usando la metodologia de
diseno para la fabricacion del producto.
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HORAS TEORIA HORAS PRACTICA
Unidades de No No
aprendizaje . . : presenci
presencial | presencial | presencial al
Estimacion de tiempo
(horas) necesario para | Fundamentos de dibujo 5 o 20 4
transmitir el aprendizaje al tecnico
alumno, por Unidad de
Aprendizaje: Introduccion al CAD: 5 0 o4 6
dibujos de ingenieria
Desarrollo ple 5 o 16 5
planimetria
Total de horas por 90
cuatrimestre:
Total de horas por semana: 6
Créditos: 6
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Nombre de la asignatura: | Dibujo Técnico Industrial

Nombre de la Unidad de

S Fundamentos de dibujo técnico
Aprendizaje:

Nombre de la practica o Mediciones de longjtud.

proyecto:

NUmero: 1 Duracion (horas) : | 2

Resultado de Utilizar los sistemas de medicion Métrico e inglés para hacer conversiones
aprendizaje: entre sistemas y entre unidades.

Pie de rey, escalimetro unidades métricas, cinta métrica de 3m,,
calculadora, tabla de conversiones, lapiz, papel, tabla con clip para
escritura. Formato de mediciones.

Requerimientos (Material
0 equipo):

Actividades a desarrollar en la practica:

- Elalumno realizard mediciones de tuercas, roldanas, tornillos, etc., utilizando el pie de rey y el
escalimetro, dependiendo del tamano del objeto y la precision deseada.

- Elalumno reportara las medidas obtenidas en el formato proporcionado por el profesor,
utilizando el sistema de medicidén que se le indique (métrico o inglés).

- El profesor orientara a los alumnos en el uso de los diferentes instrumentos de medicion,
mencionando sus principales usos, ventajas, desventajas, precision, etc.

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de los instrumentos de medicion.

Evidencias a las que contribuye el desarrollo de la practica:
ED1.Préactica: Llevar a cabo mediciones y conversiones de las mismas utilizando los sistemas de
medicion Métrico e Inglés.

10
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Nombre de la asignatura: | Dibujo Técnico Industrial

Nombre de la Unidad de

S Fundamentos de dibujo técnico
Aprendizaje:

Nombre de la practica o . . — L
Conversiones sistemas métrico - inglés.

proyecto:

NUmero: 2 Duracion (horas) : | 1

Resultado de Utilizar los sistemas de medicion Métrico e Inglés para hacer conversiones
aprendizaje: entre sistemas y entre unidades.

Pie de rey, escalimetro unidades métricas, cinta métrica de 3m, ,
calculadora, tabla de conversiones, lapiz, papel, tabla con clip para
escritura.

Requerimientos (Material
0 equipo):

Actividades a desarrollar en la practica:

- Elalumno utilizara las medidas obtenidas en la practica “Mediciones de Longitud” para hacer
conversiones del sistema métrico al inglés y viceversa.

- Elalumno utilizara las medidas obtenidas en la practica “Mediciones de Longitud” para hacer
conversiones entre diferentes unidades del sistema métrico.

- Elalumno reportara las medidas obtenidas en el formato proporcionado por el profesor,
utilizando el sistema de medicion que se le indique (métrico o inglés).

- El profesor orientara a los alumnos en el uso de la tabla y factores de conversion.

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de los factores de conversion.

Evidencias a las que contribuye el desarrollo de la practica:
ED1.Préactica: Llevar a cabo mediciones y conversiones de las mismas utilizando los sistemas de
medicion Métrico e Inglés.

11
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Nombre de la asignatura:

Dibujo Técnico Industrial

Nombre de la Unidad de
Aprendizaje:

Fundamentos del dibujo técnico

Nombre de la practica o
proyecto:

Maquetas de proyeccion de lineas y geometrias.

NlUmero:

3

Duracioén (horas) :

4

Resultado de
aprendizaje:

Definir la posicién de los objetos proyectados sobre un sistema diédrico

Requerimientos (Material
0 equipo):

Carton bateria, lapiz, regla, cinta adhesiva y material para maquetas de

carton.

Sus maquetas.

Actividades a desarrollar en la practica:

- Elalumno elaborara una maqueta para representar la ubicacién de un punto, lineas y
geometrias en los 3 cuadrantes.

- Elalumno ejercitara la percepcion de los objetos en los diferentes planos de proyeccion
- Elalumno identificara las diferentes posiciones de la recta y geometrias en un sistema diédrico
- El profesor orientara a los alumnos en el uso de los diferentes materiales para la elaboracion de

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de los instrumentos de medicion.

Evidencias a las que contribuye el desarrollo de la practica:
ED2.-Practica: Maquetas de lineas, puntos y geometrias proyectadas en un sistema diédrico.

12
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Nombre de la asignatura: Dibujo Técnico Industrial

Nombre de la Unidad de | Fundamentos del dibujo técnico
Aprendizaje:

Nombre de la practica o

proyecto: Representacion diédrica de objetos
B 4 N,
Numero: Duracion (horas): | 4
Resultado de Definir y aplicar los diversos métodos de representacion a través de las
aprendizaje: perspectivas geométricas.

Requerimientos (Material | Cuaderno de dibujo (Block), escuadras, compas, transportador de angulos,
0 equipo): escalimetro y material para dibujo

Actividades a desarrollar en la practica:
- Elalumno elaborara croquis de 10 piezas sencillas en base a vistas ortogonales

- Elalumno utilizara el pie de rey, escalimetro y flexdmetro para obtener las dimensiones de las
piezas a dibujar.

- Elalumno aplicara los tipos de lineas correspondientes para cada una de las geometrias.

- El profesor orientara a los alumnos en el uso de los diferentes instrumentos de dibujo para la
elaboracion de las representaciones

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas de dibujo

Evidencias a las que contribuye el desarrollo de la practica:
ED3.-Practica: Elabora dibujos de piezas sencillas en base a proyecciones ortogonales

13



SEP

bl"’

E bla [CA

susivenase Universidades
Politécnicas

sunsistena e INIVErsidades
Politécnicas

DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asignatura:

Dibujo Técnico Industrial

Nombre de la Unidad de
Aprendizaje:

Introduccion al CAD: dibujos de ingenieria.

Nombre de la practica o
proyecto:

Identificacion de las herramientas CAD

NlUmero:

5

Duracioén (horas) :

10

Resultado de
aprendizaje:

Reconocer los principios de los sistemas CAD.

Requerimientos (Material
0 equipo):

PC, Software CAD

14
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Actividades a desarrollar en la practica:

- Elalumno identificara y aplicara las siguientes herramientas CAD para la elaboracion de
geometrias basicas

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

Objeto/Accion Teclade lcono Menu Resultado

Dibuja un
segmento de

Linea Line / L |/ Draw = Line linea recta
desde un punto

hasta el
siguiente.

Dibuja un
circulo

cioo | cixere / ¢ |[(@) |t | bsaniose o
1= un punto central

y un radio.

Abre el cuadro
de dialogo para
configurar
'Print/Plot’.

Print / Plot

Cntl+P

Borrar Erase / E ..é Modify = Erase | Borra un objeto.
Imprimir %

File > Print

U Deshace o

Edit = Undo | revierte el ultimo
comando.

Deshacer

5

(Mo use 'Undo’ por
ahora)

15
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Comando Teclado lcono Mend Resultado
Cibuja un
rectangulo

RECTANGLE / después de que
Rectangulo m Draw > le especifique la
| Rectangle - :
REC primera esquina
y luego la
opuesta.
_ Draw > Dibuja lineas ]
Multi Lineas MLINE / ML | Sin paralela'ls sequn
cono - los parametros
Muitiline que usted defina.
— Recorta objetos
Recortar TRIM / TR +- Modify = Trim | hasta una arista

de corte.

Extiende objetos
Extender EXTEND / EX —-f Modify > Extend | hasta una arista
limite.

Compensa un

E— objeto
Compensar OFFSET / © & Modify = Offset | (paralelamente)
a una distancia
definida.
CLICK i
Object OSNAP / OS / Tools > Object | DESPlieda &l
Snaps F3 Snap Settings cuadro de
|u5mp - dialogo OSMNAF.
Concepto Teclado lcono Menu Resultado
Abre el cuadro de
dialogo de
Capa Layer / LA |"--—'-.‘_., Z Format = Layer propiedades para
Capa vy Tipo de
Linea.
Texto Text 5in Draw = Single Line | Crea _texto en una
lcono Text sola linea.
Dimension = (elja Acota objetos
Acotaciones Dim Varios | — uno) 4 dibujados
previamente.
1 Redimensiona los
Escala Scale / sc | Modify = Scale objetos

proporcionalmente

16
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Accion Teclado lcono Menu Resultado |
' . Mueve uno o
Mover Move / M + Modify > Move |, 5rios objetos.
| Copia objeto(s)
Copiar Copy / CP oa Modify = Copy | una o varias
veces.
I Estira un objeto
) _ij Maodify = después de que
Estirar Stretch / S i Stretchh ha seleccionado
una porcion de el
Crea un 'reflejo’
Reflejar Mirror / MI h Modify = Mirror de un objeto o
L - - conjunto de
seleccion.
ICONO OPCION ICONO OPCION
/ Endpoint I Perpendicular
/ Midpoint O Tangent
@ Center /6 Mearest
(o] Mode >< APPBFE!“
Intersection
O Quadrant / Parallel
)( Intersection ﬂ' None
a
—_— Extension |n Osnap Setling
2
% Insertion Point — Temporary
Tracking Point
|r—°
1 Snap From

17
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Evidencias a las que contribuye el desarrollo de la practica:
EC1. -Cuestionario; Descripcion de los sistemas CAD, elementos que lo conforman los comandos
basicos.

18
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Nombre de la asignatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Introduccion al CAD: dibujos de ingenieria.

Nombre de la practica o
proyecto:

Dibujo CAD |

Ndmero:

Duracion (horas) : | 2

Resultado de
aprendizaje:

Reconocer los principios de los sistemas CAD

Requerimientos (Material
0 equipo):

PC, Software CAD Paramétrico

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracién adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

4
R .60~

]

- Ao
c.uu

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de

piezas sencillas en CAD.

19
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DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asignatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Introduccion al CAD: dibujos de ingenieria.

Nombre de la practica o
proyecto:

Dibujo CAD II

Ndmero:

7

Duracién (horas) : | 2

Resultado de
aprendizaje:

Reconocer los principios de los sistemas CAD

Requerimientos (Material
0 equipo):

PC, Software CAD Paramétrico

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

29 —.?5/

Q)

R 125

3.00

8.00

piezas sencillas en CAD.

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de

20
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DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asignatura: Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Introduccion al CAD: dibujos de ingenieria.

Nombre de la practica o

oroyesto: Dibujo CAD Il

Ndmero: 8

Duracién (horas) :

Resultado de
aprendizaje:

Reconocer los principios de los sistemas CAD

Requerimientos (Material

L PC, Software CAD Paramétrico
0 equipo):

Actividades a desarrollar en la practica
comandos adecuados.
trabajo, acomodo de barras de herramientas)

alumnos sobre el uso de las herramientas CAD.

350 350

N

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los

A
\k/
(o

&/
ﬂ (D

30

N

4 ORIFICIDS DE D. 1.0

piezas sencillas en CAD.

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de

21
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Nombre de la asignatura: Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Nombre de la practica o
proyecto:

Introduccion al CAD: dibujos de ingenieria.

Dibujo CAD IV

Ndmero: 9

Duracién (horas) : | 2

Resultado de
aprendizaje:
Requerimientos (Material
0 equipo):

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

Reconocer los principios de los sistemas CAD

PC, Software CAD Paramétrico

2% R 110 kY

4x R 110

4% R 200

A% @ 75

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.
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SECRETARTA DI sunsistena e INIVErsidades

k bl, L Politécnicas

DESARROLLO DE LA PRACTICA O PROYECTO

susisenase Universidades
Politécnicas

Nombre de la asignatura: | Dibujo técnico industrial

Nombre de la Unidad de

T Introduccion al CAD: dibujos de ingenieria.
Aprendizaje:

Nombre de la practica o

proyecto: Dibujo CAD V

Numero: 10 Duracion (horas) : | 2

Resultado de

N Reconocer los principios de los sistemas CAD
aprendizaje:

Requerimientos (Material

S PC, Software CAD Paramétrico
0 equipo):

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

3% @ .56

L N o 2.20

50 ¢ 4.50

3x R .60

3.90

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.
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k - DESARROLLO DE LA PRACTICA O PROYECTO  Politécnicas

susisenase Universidades
Politécnicas

Nombre de la asignatura: | Dibujo técnico industrial
Nombre de la Unidad de
Aprendizaje:

Nombre de la practica o
proyecto:

Introduccion al CAD: dibujos de ingenieria.

Dibujo CAD VI

Ndmero: 11

Duracién (horas): | 2

Resultado de
aprendizaje:
Requerimientos (Material
0 equipo):
Actividades a desarrollar en la practica
El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.
- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

W( 3 ORIFICIOS DE & 1.00

L/

Reconocer los principios de los sistemas CAD

PC, Software CAD Paramétrico

0 2.50 R 100

(¥)]

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.
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E s DESARROLLO DE LA PRACTICA O PROYECTO  Politécnicas

susisenase Universidades
Politécnicas

Nombre de la asignatura: | Dibujo técnico industrial
Nombre de la Unidad de
Aprendizaje:

Nombre de la practica o
proyecto:

Introduccion al CAD: dibujos de ingenieria.

Dibujo CAD VII

Ndmero: 12

Duracién (horas) : | 2

Resultado de
aprendizaje:
Requerimientos (Material
0 equipo):

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

Reconocer los principios de los sistemas CAD

PC, Software CAD Paramétrico

N -
N\ N\
2.30
(M T
/AN S

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.
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E s DESARROLLO DE LA PRACTICA O PROYECTO  Politécnicas

susisenase Universidades
Politécnicas

Nombre de la asignatura: | Dibujo técnico industrial
Nombre de la Unidad de
Aprendizaje:

Nombre de la practica o
proyecto:

Introduccion al CAD: dibujos de ingenieria.

Dibujo CAD VIl

Ndmero: 13

Duracién (horas): | 2

Resultado de
aprendizaje:
Requerimientos (Material
0 equipo):

Reconocer los principios de los sistemas CAD

PC, Software CAD Paramétrico

Actividades a desarrollar en la practica

El alumno dibujara en el sistema CAD la pieza mostrada en la siguiente figura usando los
comandos adecuados.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

4% R 25 \—‘g
~
e -+
J \d

)

& -9

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.

N
J

100
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susisenase Universidades
Politécnicas

Nombre de la asignatura: | Dibujo técnico industrial
Nombre de la Unidad de
Aprendizaje:

Nombre de la practica o
proyecto:

Introduccion al CAD: dibujos de ingenieria.

Vistas ortogonales CAD

Ndmero: 14

Duracién (horas): | 2

Resultado de
aprendizaje:
Requerimientos (Material
0 equipo):
Actividades a desarrollar en la practica
- Elalumno dibujara en el sistema CAD las vistas ortogonales requeridas para describir la figura
que se muestra a continuacion.

- Elalumno usa la configuracion adecuada de la hoja de trabajo. (sistema de medida, area de
trabajo, acomodo de barras de herramientas)

- El profesor supervisara el desempeno de la practica y hara observaciones y sugerencias a los
alumnos sobre el uso de las herramientas CAD.

Elaborar e interpretara las proyecciones ortogonales de un objeto.

PC, Software CAD Paramétrico

CHAFLAN
0.50 x 0.50

Evidencias a las que contribuye el desarrollo de la practica: ED1.-Practica: Elabora dibujos técnicos de
piezas sencillas en CAD.
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EI'

Politécnicas

Nombre de la asighatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Desarrollo de Planimetria

Nombre de la practica o
proyecto:

Planimetria |

Ndmero:

15

Duracion (horas) :

2

Resultado de
aprendizaje:

Elaborar e interpretara las proyecciones ortogonales de un objeto en base
Reconocer los principios basicos de las normas y su

a normativas.

importancia en el dibujo técnico.

Requerimientos (Material
0 equipo):

PC, Software CAD Paramétrico

Actividades a desarrollar en la practica:

- Elalumno realizard 2 dibujos de diferentes objetos sencillos representando sus vistas
ortogonales mediante la aplicacion de un sistema de vistas normalizado a través de la
utilizacién de un sistema CAD

- Elalumno acotara las vistas elaboradas en base a la normativa definida por el profesor
- Elalumno utiliza adecuadamente las herramientas de trabajo (hardware)
- El profesor supervisara el desarrollo de la practica y registrara el desempeno del alumno

- El profesor hara observaciones y sugerencias sobre la forma y secuencia de los comandos a
utilizar para la realizacion de los dibujos y figuras indicadas.

Evidencias a las que contribuye el desarrollo de la practica: EP1.-Practica: Elabora la informacion
técnica de un producto complejo utilizando los formatos adecuados.
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sunsistena e INIVErsidades
Politécnicas

DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asignatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Desarrollo de Planimetria

Nombre de la practica o
proyecto:

Planimetria Il

NlUmero:

To Duracion (horas) : | 2

Resultado de
aprendizaje:

Elaborar e interpretara las proyecciones ortogonales de un objeto en base
a normativas. Reconocer los principios basicos de las normas y su
importancia en el dibujo técnico.

Requerimientos (Material
0 equipo):

PC, Software CAD Paramétrico

Actividades a desarrollar en la practica

- Elalumno realizard 2 dibujos de diferentes objetos representando sus vistas ortogonales mediante
la aplicacién de un sistema de vistas normalizado y seleccionando el formato de dibujo adecuado
a cada una de las piezas, a través de la utilizacion de un software CAD

- El alumno identificara la aplicacion de los tipos de formatos existentes de acuerdo al contenido de
la informacién y en base a normativas.

- El alumno identificara los elementos que conforman un plano de informacién técnica

- Elalumno generara archivos electrénicos de los dibujos que realice.
- El profesor supervisara el desarrollo de la practica y registrara el desempeno del alumno

Evidencias a las que contribuye el desarrollo de la practica: EP1.-Practica: Elabora la informacién
técnica de un producto complejo utilizando los formatos adecuados.
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sunsistena e INIVErsidades
Politécnicas

DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asignatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Desarrollo de Planimetria

Nombre de la practica o
proyecto:

Planimetria Ill

Ndmero:

17 Duracién (horas) :

2

Resultado de
aprendizaje:

Dar salida a la informacion técnica a través de la impresion de sus planos

Requerimientos (Material
0 equipo):

PC, Software CAD, impresora, plotter.

Actividades a desarrollar en la practica

- Elalumno realizard la impresion de los planos de una carpeta de informacién técnica de acuerdo a
sus tamarios de hoja correspondientes.

- Elalumno aplicara los espesores de lineas correspondientes de cada elemento del plano para su

impresion.

- El alumno identificara los equipos de impresion para dar salida a la informacién técnica.
- El profesor supervisara el desarrollo de la practica y registrara el desempeino del alumno.

Evidencias a las que contribuye el desarrollo de la practica: EP1.-Practica: Genera la carpeta de
informacion técnica de un producto complejo utilizando los formatos adecuados
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Politécnicas

DESARROLLO DE LA PRACTICA O PROYECTO

Nombre de la asighatura:

Dibujo técnico industrial

Nombre de la Unidad de
Aprendizaje:

Desarrollo de Planimetria

Nombre de la practica o
proyecto:

Gestion de informacion CAD

Ndmero:

18

Duracion (horas) : | 1

Resultado de
aprendizaje:

Gestionar la informacion técnica entre plataformas CAD

Requerimientos (Material
0 equipo):

PC, Software CAD

Actividades a desarrollar en la practica

- El alumno exportara archivos CAD con plataformas similares.
- Elalumno importaré archivos de plataformas CAD DWG i DXFi STEP i IGES

- El profesor supervisara el desarrollo de la practica y registrara el desempeno del alumno.

Evidencias a las que contribuye el desarrollo de la practica: EP1.-Practica: Genera la carpeta de
informacion técnica de un producto complejo utilizando los formatos adecuados
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) '\lrt‘lit TARIA L‘\} ‘ sussemnde UNIVeErsidades
ERUCACION PUBLICA Politécnicas
bl-a LISTA DE COTEJO PARA PRACTICAS DE MEDICIONES DE LONGITUD Y

CONVERSIONES SISTEMAS METRICO - INGLES.

sumenade Universidades
Politécnicas

UNIVERSIDAD POLITECNICA DE LA ZONA METROPOLITANA DE GUADALAJARA
DIBUJO TECNICO INDUSTRIAL

INSTRUCCIONES

Revisar los documentos o actividades que se solicitan y marque en los apartados “Sl” cuando la evidencia a
evaluar se cumple; en caso contrario marque “NO”. En la columna “OBSERVACIONES” ocupela cuando tenga
que hacer comentarios referentes a lo observado.

Valor del CUMPLE

reactivo Caracteristicas a cumplir (Reactivo) S| NO OBSERVACIONES
5%: Puntualidad para iniciar y concluir la practica.
Conducta: se conduce de manera ordenada y
5% respetando los turnos de sus companeros para
utilizar el equipo.
Uso de los instrumentos de medicion:
10% a) Escoge el pie de rey para obtener las
medidas que requieren precision.
10% b) Maneja adecuadamente el pie de rey
para obtener medidas.
20% c) Escoge el instrumento adecuado para la
obtencion de las medidas indicadas.
20% d) Hace mediciones en sistema inglés y en
sistema métrico.
5% Trabajo en equipo: colabora con sus
companeros en el manejo de los instrumentos.
Atencion: atiende las observaciones y
5% sugerencias del profesor sobre el correcto uso
de los instrumentos de medicion y tablas de
conversion.
5% Captura de datos: Registra ordenadamente los
datos solicitados.
15% Procesamiento: utiliza adecuadamente las
tablas y factores de conversion.
100% CALIFICACION:
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Subsistema de UIlth;i EEHEi |E§

LISTA DE COTEJO PARA MAQUETAS DE PROYECCION DE LARIERScas
GEOMETRIAS

DIBUJO TECNICO INDUSTRIAL

UNIVERSIDAD POLITECNICA DE LA ZONA METROPOLITANA DE GUADALAJARA

INSTRUCCIONES

Revisar los documentos o actividades que se solicitan y marque en los apartados “Sl” cuando la evidencia a

evaluar se cumple; en caso contrario marque “NO”. En la columna “OBSERVACIONES” oclpela cuando tenga
que hacer comentarios referentes a lo observado.

e d e Caracteristicas a cumplir (Reactivo) EELEEE OBSERVACIONES
reactivo SI NO
10%: Puntualidad para la entrega del trabajo.
10% Utiliza los tipos de linea adecuados.
o Representa de forma correcta la proyeccion
40% )
de las vistas en los planos
o Demuestra limpieza en superficies y trazo de
10% .
las lineas
Atiende las observaciones y sugerencias del
10% profesor sobre el correcto uso de las
? herramientas para la elaboracién de sus
proyecciones.
Demuestra exactitud en el trazado de las
20% geometrias a través del uso de las
herramientas de dibujo.
100% CALIFICACION:
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B [
LISTA DE COTEJO PARA PROYECCION ORTOGONAL DE OBJETOS

sumenade Universidades
Politécnicas

UNIVERSIDAD POLITECNICA DE LA ZONA METROPOLITANA DE GUADALAJARA
DIBUJO TECNICO INDUSTRIAL

INSTRUCCIONES

Revisar los documentos o actividades que se solicitan y marque en los apartados “Sl” cuando la evidencia a
evaluar se cumple; en caso contrario marque “NO”. En la columna “OBSERVACIONES” oclpela cuando tenga
que hacer comentarios referentes a lo observado.

Valor del . . . CUMPLE
reactivo Caracteristicas a cumplir (Reactivo) S| NG OBSERVACIONES
10%: Puntualidad para la entrega de las maquetas.

Creatividad: Muestra actitud proactiva en el
10% desarrollo de sus maquetas favoreciendo su
presentacion.

Proyeccion. Representa de forma correcta la

40% proyeccion de lineas, puntos y geometrias en
los planos

10% Calidad: Demuestra limpieza en superficies y
trazo de las lineas y monteas
Atencion: atiende las observaciones y

10% sugerencias del profesor sobre el cqrreoto uso
de los materiales para la elaboracion de las
maquetas.
Exactitud: Demuestra exactitud en el trazado

20% de las lineas, geometrias y monteas sobre las
superficies de proyeccion.

100% CALIFICACION:
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DE
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CUESTIONARIO sussonnse Universidades
Politécnicas
SISTEMAS CAD Y ELEMENTOS QUE LO CONFORMAN

ASIGNATURA: Dibujo Técnico Industrial Fecha:

UNIDAD DE APRENDIZAJE: Introduccion al CAD: dibujos de ingenieria.

GRUPO:
ALUMNO

MATRICULA

Describa que es un sistema CAD.

Describa cuales son los requerimientos para el uso de un sistema CAD

Describa como funciona y que hace de cada uno de los siguientes comandos:

New
Open
Layer
Line
Circle
Regen
Hatch
Fillet
Offset
10.Copy

© 0 N O O K~ w NP

Escriba el alias predeterminado de cada uno de los siguientes comandos:

Area
Stretch

ok NP

Help

Polyline

Explode
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LISTAS.DE COTEJO PARA PRACTICA DE FIGURAS GEOMETRICASBASICAS

UTILIZANDO EL CAD

Politécnicas

UNIVERSIDAD POLITECNICA DE LA ZONA METROPOLITANA DE GUADALAJARA

DIBUJO TECNICO INDUSTRIAL

INSTRUCCIONES

Revisar los documentos o actividades que se solicitan y marque en los apartados “Sl” cuando la evidencia a
evaluar se cumple; en caso contrario marque “NO”. En la columna “OBSERVACIONES” ocupela cuando tenga

que hacer comentarios referentes a lo observado.

el d el Caracteristicas a cumplir (Reactivo) CUMPLE OBSERVACIONES
reactivo
SI NO
5%: Puntualidad para iniciar y concluir la practica.
5% Conducta: se conduce de manera ordenada y
0 cuidando el equipo.
o Orden: sigue las instrucciones e indicaciones del
10% AN
profesor sobre el desarrollo de la practica.
Desempeiio:
25% 1. utiliza los comandos adecuados para
realizar los dibujos que se solicitan.
o 2. Las figuras y dibujos que realiza
25% n
corresponden con lo solicitado.
o 3. Hace un uso eficiente del sistema para
25% - Y .
la realizacion de los dibujos
o Entrega: guarda su trabajo en un archivo
5% >
electronico y lo hace llegar al profesor.
100% CALIFICACION:
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bl" CUESTIONARIO

NORMATIVAS Y APLICACION AL DIBUJO TECNICO

sunivenade Universidades
Politécnicas

ASIGNATURA: Dibujo Técnico Industrial Fecha:
UNIDAD DE APRENDIZAJE: Desarrollo de planimetria.

GRUPO:

ALUMNO MATRICULA

Describa que es una norma.

Describa que es ANSI, ISO y NOM y en qué paises se aplica.

Describa cual es la importancia de una norma de dibujo técnico.

Describa cuales son los elementos que conforman una norma de dibujo técnico

Describa cuales son los tamafios de formatos en base a la normativa ANSI y en qué caso aplica su
uso

Acote la siguiente figura de acuerdo a norma (dimensiones aprox.) y complete con los elementos

faltantes

/Q O\

\& O,
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EDUCACION PUBLICA

susisena e UNIVersidades
Politécnicas

bl" LISTA DE COTEJO

o Universiinde PARA PROYECTO DE INFORMACION TECNICA DE PRODUCTO COMPLEJO

Politécnicas

UNIVERSIDAD POLITECNICA DE LA ZONA METROPOLITANA DE GUADALAJARA
DIBUJO TECNICO INDUSTRIAL

INSTRUCCIONES

Revisar los documentos o actividades que se solicitan y marque en los apartados “Sl” cuando la evidencia a
evaluar se cumple; en caso contrario marque “NO”. En la columna “OBSERVACIONES” ocupela cuando tenga
que hacer comentarios referentes a lo observado.

e d el Caracteristicas a cumplir (Reactivo) ClLSELE OBSERVACIONES
reactivo SI NO
10% El proyecto se entrega el dia y hora indicados.
o Limpieza y montaje de la informacion es
10% ' >
correspondiente a lo que senalo el profesor
o Se entrega todos los planos impresos asi como la
10% ) . G I
informacion digital en CD
5% Esta impreso en los tamanos adecuados.
Utilizé los formatos adecuados para partes y
5% ensamble llenando el cuadro de datos como se
especifica.
o Los tipos de lineas y espesores son los
15% .
correspondientes
15% La acotacion aplicada es correcta
30% Las proyecciones de las vistas son correctas
100% CALIFICACION:
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SECRETARIA DE
EDUCACION PUBLICA

susisena e UNIVersidades
Politécnicas

GLOSARIO

CAD. Dibujo Asistido por Computadora, (Computer Aided Drawing)

Comandos de un sistema CAD: es una orden que se le da al programa CAD para que realice una
tarea especifica. Generalmente los comandos se escriben en la "linea de comandos" y pueden
tener argumentos que modifican su comportamiento.

Cota: indicacion de la medida de un objeto, sobre un dibujo previo del mismo, utilizando lineas,
cifras y simbolos y siguiendo ciertas normas.

Boceto: representacion grafica de un producto realizada a mano alzada
Escala. Tamafio o proporcion en que se desarrolla un plan o idea.

Estandarizaciéon. Normas que hacen posible alcanzar un nivel requerido para hacer una
herramienta, proceso o pieza.

Ejes: linea auxiliar de un dibujo que sirve de referencia para hacer acotaciones

Osnaps. Comandos que incrementan la exactitud al mover el cursor cerca de los objetos, autoCAD
forza automaticamente a ubicarse en determinadas coordenadas del objeto.

Plantilla. Modelo o molde con formas definidas y sirven como guia para realizar un dibujo.

Perspectiva. Técnica para representar en dos dimensiones, sobre una superficie plana, un objeto de
tres dimensiones.

Proyeccion. Plano horizontal y plano frontal sobre los que se representan ortogonalmente las
figuras del espacio.

Sistema Inglés: conjunto de unidades de medicién no métricas utilizadas actuamente en muchos
paises de habla inglesa.

Sistema Métrico: sistema de unidades de medicién basado en el metro, en el cual los multiplos y
submultiplos de cada unidad de medidas estan estan relacionados entre si por multiplos o
submultiplos de 10.
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EDUCACION PUBLICA

Transportador. Circulo graduado de metal , talco o papel ,que sirve para medir o trazar los angulos
de un dibujo geométrico.

Tolerancia. Diferencia aceptable en ciertas dimensiones, relativas a fabricaciones de partes
mecanicas y electronicas.

VI




SEP

SECRETARIA DE
EDUCACION PUBLICA

BIBLIOGRAFIA
Basica

- Geometria Descriptiva Aplicada/ Edit Alfaomega /Miguel bermejo herrero

- Dibujo y diseno en ingenieria/ Mc Graw Hill/ Cecil Jensen, Jay D. Hesel, Dennis R.

Short
- AutoCAD 2008/ Alfa Omega/ Rafael Avalos Bergillos/ 978-970-15-1299-9

Complementaria
- Dibujo Técnico/ Limusa/ Tamez/ 968-18-4925-6
- Geometria Descriptiva /Edit. Mir /0O.V. Loktev

- Normas de dibujo técnico Mexicanas/Dir. General de Normas/ 2006

Sitio Web
Foros AutoCad

www.hispacad.com

mexico.autodesk.com
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